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Device or Software Name:   

 

Kurzweil 3000 is an integrated scan and read (or comprehensive literacy support) 

software program that provides multisensory access to reading material with OCR and 

powerful tools for reading, writing, test-taking and learning.  It is probably best known 

for delivering relatively high quality text-to-speech capacity (through its Neo Speech 

synthesizer voices).  It combines this with document recognition options including optical 

character recognition (OCR) capability (multiple languages are supported) enabling the 

digital scanning of any document and incorporating it into the software.   The scanning 

features preserves non-text content such as graphics and figures, as well as layout, from 

the original source document.  This makes it possible to bring any printed document into 

the software.   

 

Device or Software Category (1 Point):   

 

Kurzweil 3000 falls into the Computer Access AT category, since it interprets text and 

graphics and renders them into speech.  It also falls into the Instructional Aids AT 

category, since it is used extensively in working with students with autism, ADHD, and 

other disabilities that make reading of complex text difficult  

 

Device or Software Cost (1 Point):  

 

Kurzweil 3000 is available for a 30-day free trial, after which one must purchase a 

license.  A single user license is available directly from Kurzweil Education for $1495.  

A five-user license is available for $3495. 

 

Place on AT Continuum and Why? (2 Points):   

 

Kurzweil 3000 falls primarily into the High Tech area of the AT Continuum.  The 

functionality that characterizes it as a High Tech entity are that it requires relatively 

sophisticated electronics (e.g., a personal computer (or Mac) with a relatively large 

screen, and a properly configured version of the Windows (or Mac O/S) operating 

system), a power source (i.e., electric current, or a battery), and it contains relatively 

sophisticated code to perform its functions.  Characteristics that place Kurzweil 3000 in 

the Mid-tech area include wide availability (via their website and through numerous 



educational and non-profit service organizations), and some training to become familiar 

and comfortable with its functionality (although the product is quite intuitive).   

 

 

Who can this device or software benefit and how? (3 Points):   

 

Kurzweil 3000 provides comprehensive literacy support through a relatively advanced 

text-to-speech processor that is also capable of interpreting complex objects such as 

graphics, video, charts, etc.  However, it is also an educational tool that can provide 

students with assistance relative to reading and writing, and even furnishing assistance 

with study skills and test-taking through biomodal text reading (i.e., where text is 

vocalized along with the student reading the text).  It contains numerous interfaces that 

leverage external resources as well, (i.e., online dictionaries and scanned documents).  

According to its documentation, Kurzweil 3000 is appropriate for students who have the 

cognitive capacity to learn at their grade level, but not the reading capacity; for instance, 

students who have dysgraphia or dyslexia, visually impaired students, or students who are 

English language learners (refer to the documentation at kurzweiledu.com for more 

details).  In addition, students who have attention deficient (hyperactivity) disorder 

(ADD/ADHD), autism spectrum disorder (ASD), or even learning disabilities can profit 

from the functionality of Kurzweil 3000.  Additionally, features such as study skills 

support make Kurzweil 3000 an appropriate tool for use with proficient learners/readers, 

making it a universal design tool (UDL) tool appropriate for an inclusion classroom 

comprising students of mixed capabilities. 

 

Create a comprehensive list of device or software features and explain how each 

works: (4 Points) 

 

Kurzweil 3000 contains a very rich palette of functionality for the user requiring text-to-

speech capability, but its functionality extends well beyond that to incorporate an 

impressive set of tools to facilitate reading comprehension for those with a wide range of 

disabilities, as noted above.   

 

Procurement and installation are simple.  From the kurzweiledu.com website, the 

appropriate version is downloaded.  The user receives an email containing license and 

user ID/password information.   The software installs based upon typical or custom 

configuration, and the user provides the appropriate license keys to enable the software.   

 

Below is a table that provides a summary of the key features of Kurzweil 3000 (there are 

dozens more): 

 

 

 

Function/Window Feature Description 

Kurzweil 3000 Kurzweil 3000 

Home page  

Access menu bar and ribbon features (tabbed pages for 

Read, Write and Scan), Read buttons, Audio toggle, and 

quick access Option menus. The menu bar, ribbon, and 

Option menus are available on all the tabbed pages. 



Additionally on the Kurzweil 3000 page, Read the Tip of 

the Day, Open recent documents, Open from the Library, 

Write New Draft, New Brainstorm, and New Outline, and 

Scan Documents. 

Kurzweil 3000 Read tabbed Page Click the Read tab to access frequently used Reading 

tools. 

Kurzweil 3000 Write tabbed Page Click the Write tab to access frequently used Writing 

tools, including those in the Writing Path.  

Kurzweil 3000 Scan tabbed Page Click the Scan tab to access frequently used Scanning 

tools. 

Kurzweil 3000 Read buttons  Use these Buttons for reading (stop, start, forward, and 

backward) and audio control (silent or audible) 

Kurzweil 3000 Audio Toggle Click the Audio button to toggle between audible and 

silent. 

Kurzweil 3000 Option menus Quick Access Menus for Audio, Reference, and Online 

features 

Reading Start To Start Reading 

Reading Pause To Pause Reading 

Reading Previous To Read previous reading unit 

Reading Next To Read next reading unit. 

Reading Mute To switch between Reading audibly or silently. 

Reading Reading Speed Specify the speed with which you want to read 

Reading Reading Voice Specify the voice that you want to hear reading. 

Reading Reading Mode Specify how you want Kurzweil 3000 to read 

Reading Reading Units Specify how much text to highlight as Kurzweil 3000 is 

reading 

Reading Reading Language Specify the language 

Writing Start Writing In the Writing Tools Palette, 

click the New Draft button. 

Begin writing. 
 

Writing Create New 

Text/Draft 

Document 

Do one of the following: 

In the Kurzweil 3000 tabbed page, click the New 

Draft button.  

From the Write menu or File menu, select New 

Draft Blank. 

Begin writing. 
 

Writing Create New 

Document from 

Template 

From the Write menu, select: 

New from Template. 

Or New Outline from Template. 

Or New Draft from Template. 

Begin writing by replacing the instructions with 

your own text. 
 

Writing Start New 

Brainstorm 

Diagram 

From the Write menu or the File menu, select New 

Brainstorm Blank. 

Or from the Kurzweil 3000 tabbed page click the 

New Brainstorm button.  

Begin writing from a diagram by clicking the Split 

Screen button, and writing in the right-hand Draft 

pane  
 

Writing Start New Outline From the Write menu or the File menu, select New 



Document Outline Blank. 

Or from the Kurzweil 3000 tabbed page click the 

New Outline button. 

Begin writing from an Outline document by 

clicking the Draft View button in the Outline 

palette.  
 

Edit Undo Undo your previous action. 

Edit Cut Cut selected text from a text document. 

Edit Copy Copy selected text from a document. 

Edit Paste Paste cut or copied text into a text document or into 

Notes. Or paste an image into a text file. 

Edit Select All Select all of the text in a document. 

Edit Image Selector  Select part of an image document for copying. 

Edit Insert Page Break Place a page break at the current cursor position in text 

documents. 

Edit Insert Picture Insert a picture from any file into a text document. 

Edit Picture Properties Change properties, such as dimension, or add a border for 

selected picture. 

Edit Enable Editing Allow or prevent document editing. 

Edit Move Existing 

Page 

Reorder pages in image documents. 

Edit Correct 

Recognition 

Correct underlying text in image documents. 

Edit Find Find and replace text and find highlights in typed 

documents. Find text, notes, highlights, or bookmarks in 

image documents.  

Edit Change Word 

Spacing 

To increase the readability of text, set this option and 

other text formatting and viewing options in the Text 

Options pane. See “Setting Options in Kurzweil 3000” on 

page 45. 

Edit Enable Phonetic 

Spelling 

Enable this option to help students find and correct 

phonetic errors. It can be found in the Word Prediction 

Options pane. See “Setting Options in Kurzweil 3000” on 

page 45. 

Edit Find Homophones Kurzweil 3000 provides three levels of homophones to 

help students identify and correct common homophone 

errors. For information about word lists, see “Using Word 

Lists” on page 38 and “Setting Up Word Lists” on page 

58. 

Edit Limit Spelling 

Suggestions 

Too many options may confuse instead of help students. 

Specify to Always or Never Limit Spelling Suggestions. 

This option is in the Spell Check Options pane. See 

“Setting Options in Kurzweil 3000” on page 45.  

To have students decide for themselves: select Add 

option to spelling window to enable the Fewer/More 

Suggestions button in the Spelling dialog. 

View Fit To  Specify how an image file is displayed in the document 

area. 

View Rotate Rotate an image file 90o left or right, or turn it upside 

down. 



View Thumbnails Display a thumbnail of the current page at the right side of 

the document area, or display the entire document as 

thumbnails in various sizes. 

View Page View Set to Remember the page fit and zoom level selections 

for an image document. Save the document with the page 

view settings before closing it. 

View Annotations Display or hide Notes, including Bubble Notes, Voice 

Notes, Highlighting, and Bookmarks in image documents. 

View Magnify Spoken 

Word 

Display the current word in a separate magnifier window.  

View Language list Select other reading languages. 

View Speaker list Change reading voices.  

View Pause at Empty 

Notes 

Use in conjunction with Text Notes in Fill in the Blanks 

tests. 

View Highlight Spoken 

Word  

Highlight or not highlight words as Kurzweil 3000 reads. 

View Change highlight 

colors  

For text documents, click the Text icon to open the Text 

Options pane, and select the desired color combination 

from the Reading Colors list.  

For image documents, click the Image icon to open the 

Image Options pane, and select the desired colors from 

the Word and Unit Colors lists. 

Study Skills Highlight or circle 

text 

Select the text to highlight or circle, then click the desired 

color Highlighter pen or Circle tool in the Tools Palette. 

Or click the color Highlighter or Circle tool first then 

select the text. 

Study Skills Erase highlights or 

circles 

Select the text that has color highlighting or circling, then 

click the Eraser in the Tools Palette. 

Or click the Eraser first then select the highlighted or 

circled text. 

Study Skills Find highlighted or 

circled text 

Open the Edit menu, select Object from the Find 

submenu. 

In the Find Object dialog, select Highlight. 

Click Find.  

Study Skills Create a Sticky 

Note or a Text Note 

Sticky and Text Notes are available only in image 

documents. 

Click the Sticky Note button on the Tools Palette. Or 

open the Tools menu on the menu bar, click Notes and 

choose Add Sticky Note or Add Text Note. 

Click in the text where you want to place the note. 

Type in the note, click outside the note when you are 

finished. 

Study Skills Create a Footnote Click in the document where you want to place the 

Footnote marker. 

Click the Footnote button on the Tools Palette.  

In an image document, a number marker appears in the 

note location and the Footnote window opens. 

In a text document, the text closest to the note changes to 

blue underlined text and a number appears next to the 

note. 



Type in the Footnote window. 

When you are finished, click the Close Footnote button in 

the Tools Palette. 

Study Skills Create a Voice 

Note 

Click the Voice Note button on the Tools Palette. 

Click in the document where you want to place the Voice 

Note. (In a text document, click in front of the word where 

you want to place the note.) 

In the Voice Note window, click Record (microphone), 

then begin recording. Click Stop when you are done. 

To attach a pre-recorded WAV file, click Open. Navigate 

to the file and click Open again. 

Study Skills Move a Sticky or 

Text Note using 

the mouse 
 

Point to the border of the note to 

see a four-pointed compass. 

With the compass cursor 

showing, click and drag the note 

to a new location. 
 

Study Skills Move a Sticky or 

Text Note using the 

keyboard 

TAB to the desired note. 

Press the Menu key to display the Note Right Mouse 

Button menu. 

Press the Down Arrow until Move Note is highlighted, 

then press ENTER to select. 

Use the Arrow keys to reposition the note. If you need to 

cancel, press ESC key.  

Study Skills Move a Footnote 

marker 

Works in image documents only. 

Click and hold on the Footnote marker, then slowly drag 

it to its new location on the same page.  

Study Skills Resize a Sticky or 

Text Note using the 

mouse 

Point to the right-hand border of the note to see a two-

pointed, left-right arrow cursor. 

With the cursor showing, click and drag the note to a new 

size. 

Study Skills Resize a Sticky or 

Text Note using the 

keyboard 

TAB to the desired note. 

Press the Menu key to display the Note Right Mouse 

Button menu. 

Press the Down Arrow until Resize Note is highlighted, 

then press ENTER to select. 

Use the Arrow keys to reposition the note. If you need to 

cancel, press ESC key.  

Study Skills Edit Sticky or Text 

Notes or Footnotes 

You can cut, copy, drag and drop, and paste text between 

documents and Notes. 

Click inside a Sticky or Text Note, or double-click on the 

Footnote marker to open the Note. 

Edit the text; word processing functions work in Notes. 

When finished, click outside the Sticky or Text Note. For 

a Footnote, click the Close button on the Tools Palette or 

press ESC.  

Study Skills Switch between a 

Sticky and a Text 

Note 

Click the right mouse button in a Sticky or Text Note to 

open the Note menu. 

Select Sticky Note or Text Note.  

Study Skills Find Notes Open the Edit menu, select Object from the Find 

submenu. 



In the Find Object dialog, select the type of Note you are 

looking for. 

Click Find.  

Study Skills Delete a Note  Click on the Note, Note marker or Note anchor. 

Click the Delete button in the Notes menu (right click in 

the Note to display). 

Click Yes to confirm.  

Study Skills Remove multiple 

Notes from an 

image document 

Applies to Sticky, Text and Voice Notes. 

From the Edit menu, select Image Selector. 

Click and drag the crosshair cursor to draw a box 

completely enclosing all of the Notes you want to remove. 

Press the Delete key. Click Yes to confirm. 

Study Skills Text or Sticky Note Click inside the note, then click the Read button. To 

close, click outside the Note. 

Study Skills Footnote Double-click its anchor; Kurzweil 3000 automatically 

reads. To close, click the Close button in the Footnote 

window. 

You can set up Footnotes to automatically read upon 

opening, the option must be selected in the Reading 

Options. See “Setting Options in Kurzweil 3000” on page 

45. 

Study Skills Bubble Note Double-click its purple question mark anchor (image 

document) or purple underlined text (text document). 

Kurzweil 3000 automatically reads. To close, click OK. 

Study Skills Voice Note Double-click its anchor, Kurzweil 3000 automatically 

reads. To close, click OK. 

Study Skills Open the 

Bookmark dialog 

Click the Bookmark button on the toolbar.  

Study Skills Add a Bookmark Click in the document where you want to place the 

bookmark. 

Open the Bookmark dialog, type the description, and 

then click Add. 

Study Skills Sort Bookmarks Open the Bookmark dialog, click to sort by Alphabetic 

or Reading order. 

Study Skills Go to a Bookmark Open the Bookmark dialog, click on the description of 

the Bookmark that you want to go to, then click Go To. 

Study Skills Delete a Bookmark Open the Bookmark dialog, click on the desired 

description Bookmark, and then click Delete. 

Study Skills Search for 

Bookmarks 

From the Edit menu, select Object from the Find 

submenu. 

In the Find Object dialog, select Bookmark, then click 

Find. 

 

 

 

Describe the interface the user interacts with when using this program, how is this 

beneficial, what parts of it are confusing, and how it affects people with multiple 

disabilities (ex those with physical and visual impairments)? (3 Points) 

 



Kurzweil 3000 operates with a well-designed GUI, with each object clearly labeled, and 

with workflow logically laid out.  This product is thoughtfully designed in every respect.  

In addition, every graphical object can also be enabled through a keystroke combination.  

This facilitates usability for those who are not able (or patient enough) to accurately 

operate a point or other pointing device. 
 

The initial screen is the Kurzweil 3000 tabbed page.   The Main Menu occupies the top of 

the page.   Beneath the Menu Bar is a ribbon of tabbed pages: Kurzweil 3000, Read, 

Write, and Scan. 

 

 
 

 

Beneath the Menu Bar are the toolbars that control the key functions.  These are Kurzweil 

3000, Read, Write, and Scan. The Kurzweil 3000 tab is the Home page and has several 

quick access features. The Read, Write, and Scan toolbar tabs each has a set of tools in a 

Palette along the left side of the window; you can point and click on palette buttons to 

perform frequently used functions.  
 
 



 
 
 

Each toolbar actuates specific funcationality (as outline in the section above).  Here we 

will elaborate on the Read, Write, and Scan toolbars. 

 

The Read toolbar is displayed by clicking the Read tab. Page navigation features are 

located on the left (i.e., previous and next page, entering a page number) It also contains 

an Add/Go to Bookmark button, Zoom controls, Display choices (Full page/Thumbnail 

toggle), and Print.  The online help feature guides the user very capably through the 

details of the Read feature (see below).   

 
 

 
 
 

The Writing toolbar provided the capability to format or integrate text the user generates.  

To do so, they can simply click to activate the Writing Path views (i.e., Brainstorm, 

Outline, Split Screen, or Draft). Opening the Write tab displays a palette of tools below 

the toolbar on the left side of the page. The online help feature guides the user very 

capably through the details of the Write feature (see below).   
 



 
 

The Scanning toolbar includes buttons to open the Scanner Setup dialog, Zone Editor 

dialog, and Header/Footer dialog. Opening the Scan tab reveals a palette of tools below 

the toolbar on the left side of the page. The online help feature guides the user very 

capably through the details of the Scan feature (see below).   

 

 
 

 
 

 

Interactive help is very well developed and geared toward assisting a beginning user of 

Kurzweil 3000.  It is apparent that the help capability was designed to foster independent 

learning and support to the user.   

 

To access Kurzweil 3000 comprehensive online Help pages, one can click the Help icon 

on the Main toolbar or press the F1 key. When in dialog boxes, one can click the Help 

button.   

 

To search Help pages, type the search text in the Search text box and click Search.  The 

Help feature provides a staggering amount of detailed information, but it is packaged in 

an easily consumable manner. 

 

 
 

Further product documentation is available on the kurzweiledu.com website. 

 

In summary, I found Kurzweil relatively simple to use and to learn.  This was greatly 

facilitated by the excellent interactive help features which are fully supported by the text-

to-speech functionality of Kurzweil 3000. 

 

 

Compare and contrast this device or software to one similar product: (4 Points) 

 

Read and Write Gold is available for nearly all Windows operating systems, as well as 

for Macintosh.  Read and Write Gold has many of the same features as Kurzweil 3000, in 



particular as relates to text-to-speech capabilities A complete list of the functionality 

contained within Read and Write Gold can be found at https://www.texthelp.com/en-

us/products/read-and-write-family. 

 

Unlike Kurzweil 3000, Read and Write Gold provides text masking out of the box 

(Kurzweil 3000 can be configured to support this).  This is important for visually or 

behaviorally disabled users for whom large amounts of screen text are problematic, and 

who benefit from isolating a small area of text, and especially in a bimodal (text and 

speech) setting.     

 

A cursory examination of the Read and Write Gold product resulted in these 

observations: 

 

• Procurement and installation was as simple as for Kurzweil 3000 

• The user interface was not as intuitive to me, nor as well-designed, as for 

Kurzweil 3000 

• Text formatting and control, including font size, color, and contrast, were not as 

full-featured as for Kurzweil 3000 

• Reading capabilities including references (i.e., dictionaries, thesauruses) was the 

same as for Kurzweil 3000 

• Writing capabilities were not quite as full-featured as for Kurzweil 3000 

• Study features were not as full-featured as for Kurzweil 3000 (e.g., brainstorming, 

bookmarking, highlighting). 

 

The pricing model for Read and Write Gold also differs somewhat from that of the 

Kurzweil.  Licenses are available for educational institutions as well as for 

corporatations.  An individual educational license is available for $645, which is the same 

price as the educational license.  These licenses differ only slightly, with the corporate 

version geared to support users of English as a Second Language (ESL) or with dyslexia, 

while the education package is geared to the student market.  I couldn’t find multi-user 

pricing for Read and Write Gold.  More information is available at 

https://www.texthelp.com/en-us/products/read-and-write-family. 

 

 

What difficulty would someone using this program encounter? (2 Points) 

 

One model for evaluating the efficacy of software is to compare and contrast four factors: 

usability, value, adoptability, and desirability (adopted from Guo, 2012).   

 

Usability is about how easily users can complete their intended tasks using a product. 

Kurzweil 3000 is thoughtfully designed to assure ease of use and a logical flow between 

features, and it is apparent that it was developed with an eye toward supporting students 

with various disabilities (e.g. dysgraphia, dyslexia, attention deficient (hyperactivity) 

disorder (ADD/ADHD), autism spectrum disorder (ASD)).  I expected that a product 

with functionality as broad an deep as this one would suffer from usability issues, but I 

discovered the entire package was written in a consistent, robust, and compliant manner 

https://www.texthelp.com/en-us/products/read-and-write-family
https://www.texthelp.com/en-us/products/read-and-write-family
https://www.texthelp.com/en-us/products/read-and-write-family


 

Value is related to the other elements of user experience such as usability and 

desirability, but essentially correlates to a product’s functionality and features.   As noted 

above, Kurzweil 3000 has a uniquely rich palette of features and functionality.  The price 

point could be an issue, given the basic product lists for roughly $1500. More than one 

author, aware of the funding and budget difficulties that may arise, suggested acquiring 

the 30-day trial license, and simply moving it to another computer at the conclusion of 

the trial, until funding becomes available.  I am not an advocate of such an approach, but 

the idea seems to have broad currency. 

 

Adoptability relates to the ease of access to the features of a product, while value relates 

to a product’s features and content. To improve adoptability, a product should address the 

natural context in which a user first gets exposed to their product and how it impacts the 

design of the workflow.  As noted above, Kurzweil 3000 is designed with two 

constituencies in mind – those who are visually impaired, and those with a range of 

behavioral or learning disabilities.  In this case, I found that the workflow between and 

among the features is seamlessly driven by the fundamental tasks of the disabled user.  

This is seen most clearly in the Study Skills area, which is tighly integrated both with the 

Read/Write/Scan functions, but also with functions supporting notation, reference, and 

external sources.   

 

Finally, a desirable product must be engaging and relevant to users, without sidetracks 

and loose ends. Kurzweil 3000 definitely scores well in this area.  I went to 

kurzweiledu.com and reviewed some of the blog entries, as well as some external wikis 

for users, and there seems to be a high degree of user satisfaction with Kurzweil 3000. 

 

 

Discuss the amount of training necessary to use this properly. (1 Point) 

 

Given the plethora of training and documentation available, along with interactive 

guidance available through the accompanying DVD, the learning curve is relatively flat, 

and a user should be able to utilize most of the key functions within a day or two.  There 

are online tutorials that compliment the DVD, and extensive third-party support as well.   

 

What changes to the device or software need to be made to make it better work for 

its target population? (2 Points) 

 

I tried very hard to pierce through any weaknesses in this product, and to identify areas 

for improvement.  As it is mature, with a wide following, Kurzweil 3000 is a solid entry 

into this space.   

 

As I have noted before, the main opportunity for Kurzweil Education to increase their 

coverage, exists with the advent of cloud computing.  The ability to provide both 

instantaneous software updates, as well as interactive support for solving technical issues, 

would be a definite plus for users, as well as for Kurzweil to identify new areas for 

product development. 



 

 

What factors of this device may lead to abandonment? (2 Points) 

 

The major factors that could lead a user to abandon Kurzweil 3000 are threefold: 

frustration with its capabilities; frustration with its performance; and frustration with the 

support.  Any of these are sufficient to cause any user to slow or halt their user of 

Kurzweil 3000.  In my limited experience, I would judge that users should take care to 

both ensure their hardware stack is up to the requirements that Kurzweil specifies, as well 

as maintaining software patches and otherwise ensuring they are on the current release.  

In addition, while I saw no particular performance deficit, setting reasonable expectations 

for the performance of the product is vital to user acceptance and adoption.  Users with 

older equipment may find Kurzweil 3000 to be slower than they expect from the training 

tools.  Finally, vendor support for technical and functional matters is crucial to 

maintining good usage patterns.  Even though Kurzweil Education makes no particualr 

commitment on response time, the wide availability of advice from a mature and 

enthuisatic user base makes getting help that much easier.  

 

 


